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Purpose of Guide

This Statements Guide covers everything you need to know about Tabs3 Billing statements. This
guide includes information on preparing, generating, finalizing, and updating statements, and more.

A separate Billing Methods Guide includes information on the various client billing methods that
are available in Tabs3 Billing. A separate Statement Formatting Guide includes information for
customizing the look of your Tabs3 Billing statements. Additional guides for separate software
features are also available on our Web site at:

Tabs3.com/support/docs.html

Billing Cycle Overview

Billing in Tabs3 involves several steps. The following provides a general overview of the Tabs3 billing
cycle.

Configure the Client Settings must be defined for the client to determine how
they will be billed, and where statements will be sent to.

Add Fees, Costs, and Payments Data entry in Tabs3 Billing is performed in the Fee, Cost,
and Payment programs. Fees and costs can also be
entered via PracticeMaster. Timekeepers enter their work
over the course of the billing cycle, specifying the date,
transaction code, and hours worked for each fee, and the
date, transaction code, and units for each cost. Data entry
is done on an ongoing basis throughout the billing cycle.

Run Reports and Make Some billing methods require that transactions be

Adjustments adjusted prior to billing, such as flat fee billing and split
billing. Other billing types require use of the Write-
Up/Write-Down program. More information on
adjustments can be found in the Billing Methods Guide
as well as in the Billing Adjustments Guide. Once you
have completed your adjustments, you can generate pre-
bills for the adjusted clients as needed for review.
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Generate Pre-Bills Once you are ready to start generating bills, it's time to
make sure the data was entered correctly. You can use
either Draft Statements or the Detail Work-In-Process
Report to provide pre-bill information for your
timekeepers to review for accuracy. Additionally, you can
use the Pre-Bill Tracking feature in Tabs3 Billing to track
which pre-bills have been returned.

Review Pre-Bills After you have generated your pre-bills, you can distribute
them to the appropriate timekeepers. After the
timekeepers return the approved statements, you can
make any necessary edits. Once all the necessary changes
have been made, you can proceed to the next phase.

Generate Final Statements Once all of the information on your pre-bills has been
approved, it's time to run final statements. Running final
statements begins the process of moving the transactions
included on the statement from a status of “work-in-
process” to a status of “billed”.This is important because
payments can only be applied to billed transactions.

Update Statements Updating statements completes the process of moving
transactions from a work-in-process status to a billed
status. Once a statement has been updated, you can apply
payments to the billed transactions. Additionally, the
Update Statements process applies any previously entered
unapplied payments.

Distribute Statements Once your statements have been updated, you can
distribute them to their respective clients. Methods of
distributing statements can include mailing printed
statements, emailing electronic files, or submitting bills
electronically via the Tabs3 Taskbill software.

Training Videos

You can view the following training video for more information. Clicking the link will open the
training video in your browser. All training videos are also accessible in the software via the Help |
Training Videos menu and at Tabs3.com/video.

u Statement Generation Basics
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Client Configuration

The first step to ensuring your clients are billed as desired is configuring the client settings that
affect when statements are generated, and whether they are printed or emailed.

Billing Frequency

Billing frequencies are used to define how often a client
is billed (monthly, quarterly, etc.). The billing frequency
can be used for selecting batches or groups of clients
when running statements and reports. The billing
frequency is assigned to clients on the Setup tab of the
Client file. Examples of billing frequencies include
“monthly,” "quarterly,” "annually,” "standard,”
“contingency,” "hold,” etc.

"o non

» To change the Billing Frequency

B Client Information - Williams/John

Billing Preferences Statement Optic.
Address Setup Rates A/R & Fund B
State v. Williams
Settings

Billing Categary: v Criminal Law

Glllmg Frequency: v Monthly Cllents)

Figure 1, Client File - Billing Frequency

1. From the Quick Launch, search for and select “Client Information.”

Select the desired Client ID.
Click the Setup tab.

M won

Select the desired Billing Frequency.

5. Click % to save the client.
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Release to Bill and Bill on Demand
The Release To Bill and Bill On Demand check boxes on the Billing Preferences tab of the Client file
determine whether a statement will be included the next time statements are generated.

Release To Bill If the Release To Bill check box on the Billing Preferences
tab of the Client file is cleared, then the client will not have
a statement printed regardless of whether the client has a
previous balance or work-in-process. This check box must
be selected in order to have a statement printed.

Bill On Demand if the Bill On Demand check box is selected, the Release
To Bill check box will automatically be cleared when the
Update Statements program is run. This is done to prevent
the client from automatically being billed the next time
batch statements are printed. Clients with a status of Bill
On Demand are usually billed by running single
statements instead of being billed in a batch.

E Client Information - Larson/Michael

Address Setup Rates AR &
Billing Preferences Statemen

Client 1D: 100.00 ) Larsoanld.
Larson v. Be

Billing Status
[TRelease To Bill [1Bill On Demand !

Figure 2, Client File - Billing Status

» To release a client to bill

1. From the Quick Launch, search for and select “Client Information.”
Select the desired Client ID.
Click the Billing Preference tab.

M oW

Select the Release to Bill check box.

5. Click B to save the client.
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Statement Delivery Options

Statements can be set up to Client Information - MegaConstruction

be printed and mailed, saved Address Setup Rates A/R & Fund Balances Client Notes Custom Fiele,
as a PDF and emailed, or Billing Preferences Statement Options split Billing

. " : - MegaConstruction Corporation
bOth Statement DellVery Client 1D: v Corporate Merger - Megabuilders and BuilderCorp
Options are specified on the Billing Status
Billing Preferences tab of the Release To Bill [Jeill on Demand [progress silling

Client file in individual Bill To

records. You can double-click || &""**
a Bill To record in the table to Instructions
review or edit it.

Spel]
Statement Delivery Options
Bill Te Name Description Mail Email ~ .
Add
MegaConstruction Corp | Address shown on the Address tab m
Tatiki, Sr./James R. No Yes Edit

[JUse a password to protect PDF statements when emailed:

Figure 3, Client File - Billing Preferences tab

Bill To Records

Bill To records consist of information associated with a recipient of a client’s mailed or emailed
statement. Each Bill To record is associated with a contact (except when associated with a secure
client). Bill To records include additional billing information not stored in the Contact file, such as
whether a statement will be mailed and/or emailed, which mailing address or email address will be
used, whether an Attention line is included, and more.
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An additional Bill To record Bill To Record ?
can be added to send
statements to a different Bill To Name: | Tatiki, Sr,/James R. v James R. Tatiki_Sr.

contact. Each client can have | pescription: |

up to two Bill To records.
Staternent Delivery Options

[ Mail Statement

[ Email Statement
(O Print the Client's Name and Address on the Statement
(®) Print the Bill To's Name and Address on the Statement

Statement Address

Business® | | PO Box 723435
201 E 48th Street
Manhattan NY 10017-1538

[ include attention line on statement
(®) Matter's Contact Name: James R. Tatiki, Sr.
O other:

Email Delivery Options

Email 1* ~ |jt@megaconcorp.ccm

Email Template: | OnlinePayment2 v Online Payment - 'Click Here' Link
Cancel Delete

Figure 4, Bill To Record window

» To add a Bill To record

1. From the Quick Launch, search for and select “Client Information.”
2. Select the desired Client ID.

3. On the Billing Preferences tab, in the Statement Delivery Options section, click the Add
button.

4. Select a Bill To Name.
5. Enter a Description to help identify this Bill To Record.

6. Select whether the contact will receive statements by mail, email, or both.
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7.
8.

Select the Statement Address and/or Email Delivery Options based on the delivery selection.

Click OK to save the Bill To record.

You can change whether a statement is mailed or emailed at any time.

» To change whether a statement is mailed or emailed

1.
2.

From the Quick Launch, search for and select “Client Information.”
Select the desired Client ID.

On the Billing Preferences tab, in the Statement Delivery Options section, select the
desired Bill To Name.

Click the Edit button.
In the Statement Delivery Options section, select or clear the desired options.

Click OK to save the Bill To record.

Eill To Record

Bill To Name: | Larson/Michael

Description: |Address shown on the Address tab

Statement Delivery Options
Mail Statement

[¥] Email Statement

Print the Client's Name and Address on the Statement

Print the Bill To's Name and Address on the Statement

Figure 5, Bill To Record - Statement Delivery Options

More Info: Additional information on Client settings that affect billing and statements can be
found in the Billing Methods Guide and the Statement Formatting Guide.

Integration with Trust Account Software

If you are integrating with Trust Accounting Software (TAS), trust information can be included on
statements. Additionally, Tabs3 Billing and TAS can be configured to generate automatic payments
from TAS that are included on statements. For more information including how to configure these
features, refer to the Integration Guide.
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Training Videos

You can view the following training video for more information. Clicking the link will open the
training video in your browser. All training videos are also accessible in the software via the Help |
Training Videos menu and at Tabs3.com/video.

n Getting Started with Clients
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Data Entry

When entering transactions, the Bill Code and Status fields determine whether the transaction is
billed or shown on the statement.

Bill Code

The Bill Code indicates whether the transaction is billable or non-billable (i.e., no charge), and the
printing status.

The following Bill Codes are available for fee and cost entry:

« Billable/Printable

« Non-Billable/Non-Printable
« Non-Billable/Printable

« Billable/Non-Printable

« Billable/Always Print

Non-printable transactions will not be shown on a statement regardless of whether they are billable
or non-billable. Likewise, non-billable transactions will not incur a charge on the statement,
regardless of whether they are printable or non-printable. Bill Codes are not available for payments.

[,

The majority of transactions entered

are Billable/Printable. Bill Code: 0 - Billable / Printable
0 - Billable / Printable
Rate Code: 1 - Mon-Billable / Mon-Printable

2 - Mon-Billable / Printable
3 - Billable / Mon-Printable
4 - Billable / Always Print

Fee Entry List

i

|Ref... .BC H/P ,_  Date  Tmlr—Mrsta Rill

Figure 6, Fee File - Bill Code

Status

The Status field determines whether the transaction is eligible
to print on a statement. It also indicates whether a transaction Status: |P - Print

t
has been shown on a final statement but has not yet been . [H-Hold 3
i
updated. 5 - Save i

Amount Dessriptinns.  msbom

o

Figure 7, Fee File - Status
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Hold

Print

Update

Save

Save/Update

Puts a transaction on hold and prevents the entry from
being billed until it is changed to a Print status. This status
is available for Fee, Cost, and Payment entry.

Allows a transaction to print on a client’s statement. New
entries automatically default to Print. This status is
available for Fee, Cost, and Payment entry.

Indicates that the transaction has been final billed and is
ready to be updated by the Update Statements program.
You will not be allowed to edit the Status field when
Update is shown. If you want to change this field, you
must first unbill the statement. This status is available for
Fee, Cost, and Payment entry.

Has the same function and print status as Print but the
transaction is saved after it has been shown on a final
statement and updated. Instead of being deleted after
printing on a statement, saved transactions remain in the
fee file for repeated billings until they are deleted or
changed to Print. This status is available for Fee and Cost
entry.

Indicates that the transaction is a saved transaction that
has been final billed and is ready to be updated by the
Update Statements program. You will not be allowed to
edit the Status field when Save/Update is shown. If you
want to change this field, you must first unbill the
statement. This status is available for Fee and Cost entry.

The majority of transactions are entered with a status of Print.

-10-
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Statement Preparation

Before generating statements, perform the following steps.

1. Make sure Release To Bill is selected for all clients for which a statement should be printed
(page 4).

2. Make sure all transactions to be included on a statement are set for Print and not Hold (page
9).

3. Optionally run draft statements or Work-In-Process reports to review work that needs to be
included on statements (page 12).

4. Optionally use the Reorder Fees utility to change the order in which fees with the same date
are displayed on statements (page 12).

5. Optionally make adjustments (Write-Up/Down, Flat Fee, Split Fee) (page 11).

Making Adjustments

Depending upon how your clients are set up, you may need to run one or more of the following
utilities prior to generating statements:

Write-Up/Write-Down The Write-Up/Write-Down Fees and Costs program allows
you to write-up or write-down total unbilled fees, costs, or
hours for a client for a range of timekeepers, transaction
codes, categories, or dates for a client prior to billing.
Write-ups/write-downs can be adjusted to a specified
amount or by a specified percentage.

Adjust Flat Fee Clients The Adjust Flat Fee Clients program allows you to adjust
fee transactions in work-in-process to equal the flat
amount assigned in the Client file. The Adjust Flat Fee
Clients program only adjusts fee transactions for clients
whose Billing Rate Code is "0" (zero). Cost transactions are
not adjusted.

Perform Split Billing The Perform Split Billing program allows you to split the
fee and cost transactions in work-in-process to equal the
split fee percentages defined on the Split Billing tab of the
Client. This program will copy the transactions to the split
clients and adjust the Hours and Amounts of the specified
transactions.

11 -
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More Info: Additional information on these utilities can be found in Tabs3 Billing Help, the Billing
Methods Guide, and the Billing Adjustments Guide.

Training Videos

You can view the following training videos for more information. Clicking a link will open the
associated training video in your browser. All training videos are also accessible in the software via
the Help | Training Videos menu and at Tabs3.com/video.

u Flat Fee Billing

u Split Billing

Reorder Fees

Menu: Statements | Statement Preparation | Reorder Fees
Home: All Actions | Statement Preparation | Reorder Fees
Quick Launch: Reorder Fees

Depending on the reference number that is assigned when fees are entered, the order in which fees
are shown on the statement may not be as desired. For example, if a fee for “"Review document” is
entered and assigned a reference number of 1, and then the fee for “First draft of document” is
entered and assigned a reference number of 2, the statement could show that the document was
reviewed before the first draft was created. The Reorder Fees utility allows you to change the order in
which fees with the same date are displayed on statements by moving fees up and down within the
list.

» To reorder fees on a statement

1. From the Statements menu, select Statement Preparation and then click Reorder Fees.
2. Select the desired Client ID.

3. Select the transaction you want to move and then click the Move Up or Move Down button.

Note: Moving fees up or down via the Reorder Fees utility changes the reference number of the
fees.

Pre-Bills: Detail WIP Report vs. Draft Statements

Most firms run Pre-Bills one of two ways: printing a Detail Work-In-Process Report (Detail
WIP Report), or printing Draft Statements. Both of these options update the Pre-Bill Tracking

-12-
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program (page 21); however, each option offers different features. The Detail Work-In-Process
Report provides a list of transactions in a report format that includes additional detailed information
for each transaction, whereas draft statements provide a list of transactions in statement format.

Work-In-Process Reports

Menu: Reports | Work-In-Process | Detail Work-In-Process

| Summary Work-In-Process
| Aged Work-In-Process

Home: All Actions | Statement Preparation | Detail Work-In-Process

| Summary Work-In-Process
| Aged Work-In-Process

Quick Launch: Detail Work-In-Process Report
Summary Work-In-Process Report
Aged Work-In-Process Report

Work-in-Process reports are valuable tools that show all unbilled fees, costs, and payments. Work-
in-Process reports can be run in a detailed or summary format, or to review aged Work-In-Process.
Tabs3 Billing includes the following Work-In-Process reports:

Detail Work-In-Process

Summary Work-In-Process

Aged Work-In-Process

» To run a Work-In-Process Report

The Detail Work-In-Process Report shows the detail of all
fees, costs, and payments entered for the client. The
detailed report can be used to review work-in-process
prior to billing. Some firms use Detail Work-In-Process
Reports in lieu of running draft statements.

The Summary Work-In-Process Report shows the client’s
previous balance and totals for any fees, costs, or
payments in work-in-process. A current balance is
calculated and shown. The client funds balance is shown
as well. This report allows for a quick review of the client's
status.

The Aged Work-In-Process Report shows the age of all
unbilled charges by client.

1. From the Statements menu, select Statement Preparation and then click the desired Work-

In-Process report.

2. Select the desired report criteria.

3. Click OK.

13-
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Generating Statements

Statements are run using the Generate Statements program.

Generate Statements Program

Menu: Statements | Generate Statements
Home: All Actions | Statements | Generate Statements
Quick Launch: Generate Statements

The Generate Statements program allows you to print an individual client’s statement or a batch of
clients’ statements in draft or final mode. The Generate Statements program includes a Client tab, a
Transactions tab, an Options tab, and a Sort tab.

i Generate Statements. & Generate Statements.

Client  Transactions Options Sort Client ~ Transactions Options Sort

Client ID: ‘ [ o] v Multiple...
Irees Fee Timekeeper: l:l v Thru: I:l v
Fee Date: | ddryyyy ‘ v Thra: ‘ dd/yyyy ‘ V
Nomesearct | e | etode [ Jv | v

ctegor: | |v e v

CJonly Include Fee Credits

Primary Timekeeper:

Secondary Timekeeper:

(-

L1~
Originating Timekeeper: l:l v Theu

(I

et s e b b, i s, B -+ b i, b |

A A e A Ay o 8 B0 o B A P bAoAt P Bt t s

Category: Thru; v [Fadvances  Cost Date: | dd/yyyy ‘v Thru: ‘ dd/yyyy ‘v
Cost Teode: E || v
Billing Frequency: @Al Ospecific Select Billing Frequency... Cost Type: D Thru: D
Location: @all O specific Select Location... [ only Include Cost Credits
Status: ®al O specific Select Status...
Dpayments  PaymentDate: | mmvddfyyy | v Thru: [ mmzddrygy | v
[o] /Cl Dates: ] if elec (9
pen/Close Dates @al O specific Select Dates peyment Teode: l:l . Thru: l:l .
Figure 8, Generate Statements Figure 9, Generate Statements
Client tab Transactions tab

-14-
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(L Generate Statements L Generate Statements

Client  Transactions Options sort client  Transactions Options Sort

Statement Type Statement Options

Report Order secondary Order
Statement Date: 08/22/2022 | v
®oratt @ primary Timekeeper @ Client ID
Print Reference Numbers ) 5 "
U eginming Statement Number O secondary Timekeeper O client nsme search

[ Update Pre-Bill Tracking
Last Numbers Used: 7614 thru 7614 O originating Timekeeper
print illing Notes & Instructions

s ahn A at P et e A b e i el

1
)
1
b
1
q
{
4
3
O Final Statement Template Working Timekeeper i
{
Use Original Statement Number Email Template O category i
ONone J
i
Print Criteria Start Each Sort on a New Page
[ Zero Balance Payment Only Clients [print Reminder Statement for Clients {
[ Task Based Billing Information Detail Totals g
' ’ , b
[ cover Statement Cnly Summary Totals only !
Statement Run Totals mmyddyyyyy 4
Subtotal by Client 4
[ criteria Page Include Clients: {
Ovwith actvity Client Subtatals Only i
L
Gutput Options O without Activity ! Grand Totals !
Number of Copies: [: @ Both ;
{
[1PDFs as Individual Statements Cexclude Credit Balance Only Clients 3 M
(Using DropBox or Print to File/PDF) Select Age of Past Due Clients: |0 ) f 1}
Threshold Billing 1 <
{ :
i
; !
j i
Figure 10, Generate Statements Figure 11, Generate Statements
Options tab Sort tab
Client tab The Client tab allows you to specify a range of clients,

timekeepers, categories, billing frequencies, locations,
open dates, and close dates. You can also select clients
based on status (i.e., active clients, progress billing clients,
billable clients, email and/or mail clients, and task based
billing clients).

Transactions tab The Transactions tab allows you to specify the
transactions to be included based on transaction type
(fees, costs or payments), date, transaction code, working
timekeeper, category, and cost type.

-15-
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Options tab The Options tab allows you to specify the statement date

and the minimum fee, expense, and advance amounts to
be billed. You can select if you want to print reminder
statements or statements for clients with current work.
You can include only clients with past due amounts
greater than a specified number of days. If you number
statements at the firm level, you will be prompted to enter
the beginning statement number. If you print draft
statements, you can elect to print reference numbers for
the individual transactions, update pre-bill tracking
information, and select whether you want billing notes
and instructions included. You can select whether you
want statements for task based billing clients to include or
exclude task based billing information. You can specify
the number of copies you want printed, and whether or
not you want to include Statement Run Totals and a
Criteria Page. If generating PDF files for statements, you
can elect to generate individual PDF files for the statement
run. You can select to print cover statements only. If
desired, you can override individual statement template
options or specify a different statement template for a
particular batch of statements.

Sort tab The Sort tab allows you to select the order in which the

information should appear on reports.

When draft statements are displayed using the Preview option, you can drill down to individual
client, fee, cost and payment records allowing you to edit data directly from the Preview window.
When final statements are printed or displayed using the Preview option, email statements are sent
to the Email Statements window for review.

Some firms will run batches of statements by timekeeper.

» To generate a batch of statements for a specific primary timekeeper

1.

OIS N

From the Statements menu, click Generate Statements.

From the Client tab, select a Primary Timekeeper range.

From the Options tab, select to print a Draft or Final statement.
Select any other desired options.

Click OK.

-16-
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Tip: You can generate batch statements for all timekeepers at the same time and have them sorted
by primary timekeeper. To do this, select a Report Order of Primary Timekeeper on the Sort tab.

Which Clients Will Have Statements Printed?

When statements are run, the options selected in the Generate Statements program as well as a
client’s previous balance, work-in-process, and client information settings determine if a statement
will be processed.

« Generally, clients with a previous balance or work-in-process that is released for billing will
have a statement processed.

« You can select to include clients with work-in-process, without work-in-process, or both. If
desired, reminder statements can easily be printed that will not include current work-in-
process.

« If the Release To Bill check box for a client is cleared, then the client will not have a
statement printed regardless of whether the client has a previous balance or work-in-
process. This check box must be selected in order to have a statement printed. Keep in mind
that if the client’s Bill On Demand check box is selected, the Release To Bill option will
automatically be cleared when the Update Statements program is run. This occurs in order to
prevent the client from automatically being billed the next time batch statements are printed.
Clients with a status of Bill On Demand are usually billed by running single statements
instead of being billed in a batch. (Exception: Clients whose Bill On Demand check box is
selected and Release To Bill check box is cleared will have a reminder statement generated.)

« If desired, you can also specify threshold billing options at the client level or when printing
statements so that only clients with work-in-process that exceeds a specified amount will be
billed.

« When generating email statements for clients, the statements are output to the Email
Statements window when running final statements. However, if a client is configured for
both email and mail statements, the statement is printed and sent to the Email Statements
window. Draft statements are not sent to the Email Statements window.

More Info: A checklist of potential reasons why a statement doesn’t print can be found in
KB Article R10004, "My Statement Doesn’t Print.”

-17-
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Using Report Definitions to Define Batches

Tabs3 Billing allows you to save all of the parameters specified for statement runs and individual

reports as report definitions. This feature saves time when running statements on a regular basis by

streamlining the process of selecting the options.

When saving a report definition, Tabs3 Billing also allows you to specify that the report definition

should be used as the default for the report. The next time any user selects the report, the options

from this report definition will be used by default.

The reports that allow you to create and use report definitions include two buttons in the report
window: the Load button and the Save button.

Load

Save

The Load button can be used to retrieve a previously saved
report definition for statements. The Report Definition List

(Figure 12) will be displayed, allowing you to select a
report definition.

The Save button can be used to save the specified options
as a report definition. The Save Report Definition window

will be displayed, allowing you to specify a report
definition name and description.

8 Report Definition List m| x
[ show All Report Types [ show Other Users' Reports
Default Name Report Type User ID Description ol
radef Receipt Allocation CHERYL Receipt Allocation Default
- defstmt Statements _ Default Statements
reminder Statements CHERYL Reminder Statement Defaults
Vv tkadef Tmkpr Analysis CATHY Timekeeper analysis Default
Vv  tkprof Tmkpr Profitability ROM Timekeeper Profitability
Vv  qtrikrea Tmkpr Realization JEN Quarterly Timekeeper Realization
Vv  tkprod Tmkr Prod Rpt CHERYL Default Timekeeper Productivity W
Cancel Delete Rebuild Help

Figure 12, Report Definition List

-18-
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Draft vs. Final

One of the most important concepts in Tabs3 Billing is the Statement Type i
difference between "draft” statements and “final” O Draft }1‘
statements. When running statements, the Options tab is Print Reference Numbers 7
used to specify whether you are running draft or final Update Pre-gill Tracking ;
statements. Print Billing Notes & Instructions }
® Final ;

[Juse original Statement Number ‘1

f

Draft Statement

Final Statement

i i B Ty e

Figure 13, Generate Statements window
Draft vs. Final

Draft statements do not alter any information in the data
files and can be run at any time. Because of this, multiple
draft statements for a client can be run at any time during
the billing cycle as needed. When draft statements are
displayed using the Preview option, you can drill down to
individual client, fee, cost, and payment records allowing
you to edit data directly from the Preview window. Many
firms will select the option Print Reference Numbers to
make it easy to quickly look up transactions for editing
purposes.

Final statements can also be run at any time; however,
when final statements are run, the Status field is changed
to U-Update for each transaction included on the
statement. This indicates that the entry has been billed and
is ready to be updated by the Update Statements program.
This “U" can be seen on the Detail Work-In-Process
Report, the Transaction File List and in the Status field
when editing the transactions. You can edit a transaction
that has U-Update in the Status field, but you should
reprocess another final statement that reflects the
changes. You cannot delete a transaction that has U-
Update in the Status field. You must first “unbill” that
client and then you will be allowed to delete the
transaction.
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The changes that are made to the data files by running
final statements are not permanent until the Update
Statements program is run. This means that you can run
final statements multiple times. However, whatever
information was shown on the last final statement for the
client is the information that is updated by the Update
Statements program.

Reminder Statements

Reminder statements can be sent to clients to encourage Critaria
. . B Print Reminder Stat t for Client
timely payment of past work. Reminder statements are print Reminder Statement for Clients

oy

generated by selecting the Reminder Statement check box g:j:r"naw
on the Options tab of the Statements program. You can With no Statement Since: v
select whether you want to use a detail or summary format. ineude Cliante f
A summary reminder statement includes the client’s Owith Activity 3
previous balance and any unprocessed payments, but does Owithout Activity 4
not include current fees and costs. A detail reminder @Both :'
statement includes this same information as well as a history | [JExclude Credit Balance Only Clients ;
showing amounts billed and due for each outstanding Select Age of Past Due Clients: |0 Mt
statement. Threshold Eilling "
s gl

Figure 14, Generate Statements window

Reminder Statements
Previous Balance $2,205.75
Stmt Date Stmt # Billed Due
05/31/2022 7587 75.00 75.00
06/30/2022 7591 131.00 131.00
07/31/2022 7595 1,999.75 1,999.75
2,205.75
Balance Due $2,205.75

Figure 15, Example of a Detail Reminder Statement

Previous Balance $2,205.75
Balance Due $2,205.75

Figure 16, Example of a Summary Reminder Statement
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Tracking Statements

The Pre-Bill Tracking program can be used to track statements to see where they are at in the billing
process. Pre-Bill Tracking uses records generated by running either Work-In-Process reports, or
running Draft statements.

Batch Numbers

Tabs3 Billing automatically assigns a unique batch number to each run of draft statements and each
Detail Work-In-Process Report for use by the Pre-Bill Tracking program. The previous batch number
is automatically incremented by “1,” regardless of whether a report or statement actually prints. The
batch number is shown in the Pre-Bill Tracking window. Specific batch numbers can be included in
the Pre-Bill Tracking window. Additionally, pre-bill tracking records can be deleted based on a batch
number.

More info: Steps on running a batch of statements can be found on page 16 of this guide.

Pre-Bill Tracking

Menu: Statements | Pre-Bill Tracking
Home: All Actions | Statements | Pre-Bill Tracking
Quick Launch: Pre-Bill Tracking

The Pre-Bill Tracking program is used to review, modify, or delete the pre-bill tracking records that
have been created by running pre-bills or final statements. Either draft statements or Detail Work-in-
Process Reports can be used as pre-bills. This program makes it easy for the billing clerk to track the
status of individual client’s pre-bills and final statements. Records can be easily sorted for a specific
Primary, Secondary, or Originating timekeeper or a range of timekeepers.

If a pre-bill has been run for the client, the date shown on the most recent pre-bill is included in the
“Pre-Bill” column of the Pre-Bill Tracking window. If a final statement has been run for the client, the
date shown on the most recent final statement will be shown in the “Final” column. Pre-Bill Tracking
records can be marked as “on hold” or “reviewed.” Final statements can be printed for selected
clients from within the Pre-Bill Tracking window.

A Pre-Bill Tracking Report can be printed showing the pre-bill tracking records that meet specified
criteria.
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(84 Pre-Bill Tracking E=x EoR (=
Client ID Client Name Des:riptiun Timekeeper Pre-Bill- H R Final Batch ~

oz o
121.01 Phillips/Marcus Real Estate Acquisition 1 - Michael L. Jensen 07/13/2022 07/31/2022
200.01 Peterson Insurance Co. General Legal Counsel 1 - Michael L. Jensen 07/13/2022 07/31/2022 45
200.02 Peterson Insurance Cao. Maintenance of Insurance 3 - Ronald P. Anderson 07/13/2022 Vv 0773172022 45
415.00 MegaConstruction Corpor. Corporate Merger - Mega 3 - Ronald P. Anderson 07/13/2022 45
850.00 White/Kelly Divorce 5 - Kendra I. Michaels 07/13/2022 45
osn N1 \Athita ¢ alh Lact \Afill_81 Tactamant. 5 - Wondra | _Kdichaslc N7122027 AS Y
Options Hold Reviewed Final Statements Refresh Print Report Reorder Fees

Figure 17, Pre-Bill Tracking window

Clicking the Options button in the Pre-Bill Pre-Bill Tracking Options %
Tracking window (Figure 17) displays a Pre-Bill Fitter
Tracking Options window (Figure 18) that lets Onclude Final O Exclude Final @goth Cancel
you specify exactly which pre-bill tracking @IETRiE  @EEnhiEd Ol e

records to include in the window and on the Pre- | ©ndude Reiewed Oiclude Reviened @ goth

Bill Tracking Report. Options include the ability

@® all Batch Numbers

to select the statements on hold, statements O Specific Batch Number.
outstanding (not reviewed), a specific batch
number, and which timekeepers to display. Timekeeper
@ Primary (O Secondary (O Originating

Report Options

[[Istart Each Timekeeper on a New Page

Figure 18, Pre-Bill Tracking Options window

For example, let's say that Mary prints draft statements for primary timekeeper 1 and gives them to
the attorney for approval. As the attorney returns the draft statements to Mary, Mary edits the
transactions as needed, and then she marks the statement as reviewed in the Pre-Bill Tracking
window. Mary can easily see which draft statements, if any, have not yet been returned and can
follow up with the attorney as needed. At any time, Mary can easily run final statement for any or all
of the clients with reviewed statements via the Pre-Bill Tracking window by clicking the Final
Statements button.
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Pre-Bill Tracking Report

The Pre-Bill Tracking Report is accessed from within the Pre-Bill Tracking program and includes the
pre-bill tracking records that are displayed at the time the report is run. The report can be sorted by
Client ID, Client Name, Description, Timekeeper, Pre-Bill Date, Hold Status, Reviewed Status, Final
Date, or Batch by clicking the column header in the Pre-Bill Tracking window. Clicking the Options
button (Figure 18) in the Pre-Bill tracking window allows you to select to print each timekeeper on a

new page if desired.

Date: 08/22/2022

Client
100.00M
101.00M
121.01M
200.01M
200.02M
415.00M
850.00M
850.02M
850.01M

Name

Larson/Michael
Williams/John
Phillips/Marcus
Peterson Insurance Co.
Peterson Insurance Co.

MegaConstruction Corporation

White/Kelly
White/Kelly
White/Kelly

Pre-Bill Tracking Report
Jensen, Martin & Anderson, P.C.

Description
Larson v. Bel-Cor

State v. Willams

Real Estate Acquisition

General Legal Counsel

Maintenance of Insurance Policies

Corporate Merger - Megabuilders and BuilderCor
Divorce

Medical Care of Brianne

Last Will & Testament

Pre-Bill
07/12/2022
07/13/2022
07/13/2022
07/13/2022
07/13/2022
07/13/2022
07/13/2022
07/13/2022
07/15/2022

Hold

Reviewed

R

R

Final
07/31/2022
07/31/2022
07/31/2022
07/31/2022

Page: 1

4
7
i

U\NUIWQAAMA‘

Figure 19, Example of a Pre-Bill Tracking Report
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Finalizing Statements

The processing of final statements is a two-step process. The first step consists of running a final
statement; the second step consists of updating the final statement by running the Update
Statements program.

Once a final statement has been generated, you are ready for a final review. You can optionally use
the Pre-Update Statements Report to review which clients will be updated. After reviewing which
clients’ statements will be updated, running the Update Statements program is a key step in the
billing process. The Update Statements program archives all transactions that were on the statement,
which means that payments are allocated appropriately, accounts receivable is up to date, and
transactions cannot be billed on another statement.

Pre-Update Statements Report

Menu: Statements | Pre-Update Statements Report
Home: All Actions | Statements | Pre-Update Statements Report
Quick Launch: Pre-Update Statements Report

The Pre-Update Statements Report is used to print a report showing the amounts that have been
processed on final statements that are ready to be updated by the Update Statements program. The
report shows amounts for previous balance, fees, expenses, advances, finance charge, payments,
and balance due. The statement number and statement date shown on the final statement are
included for each client.

Date: 08/222022 Tabs3 Pre-Update Statements Report Page: 1
Jensen, Martin & Anderson, P.C.

Stmt # Client Name/Work Description Date Prev Bal Fees Expenses Advances Fin Chg Payments Bal Due

7615 100.00 Larson/Michael 07/31/2022 0.00 0.00 0.00 0.00 0.00 0.00 0.00 MLJ
Larson v. Bel-Cor

7618 101.00 Williams/John 07/31/2022 299440 106250 0.00 0.00 0.00 0.00 4,086.90 PAM
State v. Williams

7616 121.01 Phillips/Marcus 07/31/2022 574885  2,337.50 0.00 0.00 000  -5,000.00 3,086.35 MLJ
Real Estate Acquisition

7617 200,01 Peterson Insurance Co. 07/31/2022 272535  5,600.00 12.00 0.00 0.00 0.00 8337.35 MLJ
General Legal Counsel

Total 1146860  9,000.00 12.00 0.00 000 500000 1548060

Figure 20, An example of the Pre-Update Statements Report

» To run a Pre-Update Statements Report

1. From the Statements menu, click Pre-Update Statements Report.
2. From the Client tab, enter the desired Client ID range.
3. Click OK.
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Update Statements Program

Menu: Statements | Update Statements
Home: All Actions | Statements |
Quick Launch: Update Statements

When the Update Statements program is run, all fee, cost, payment, and client funds transactions
that have been billed on final statements will be updated. You can update one client, a range of
clients, or all clients. You can update clients for a specific primary, secondary, or originating
timekeeper or a range of timekeepers. This program represents an important “turning point” in the
billing cycle. Final statements can be rerun as many times as required until the statement is as
desired. However, once the Update Statements program is run, it essentially finalizes the information
that was included on the client’s last final statement. These transactions are archived and are
removed from work-in-process.

Additionally, the information on the client’s last final statement is updated to accounts receivable
and various other productivity figures. Email statements can be emailed via the Email Statements
window once the attached final statements are updated.

Unallocated payments are allocated for e e ==
those clients being billed who previously | )
had no due amounts.
Timekeepers

®) Primary

(O secondary  From: I:l v Thru: I:l v

O Criginating

o

Figure 21, Update Statements window

» To update statements

1. From the Statements menu, click Update Statements.
Enter a Client ID range, or leave it blank to include all clients.
Optionally specify a Timekeeper range for which statements are to be updated.

Click OK.

M oW
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Tip: It is important to note that you must run the Update Statements program before running the
productivity and accounts receivable reports. The Update Statements program updates all billed
fees, costs, payments, and retainers (regardless of the Statement Date) to accounts receivable and
the client ledger file as well as the current month's timekeeper, category, and transaction code
productivity figures. If productivity or accounts receivable reports are printed before updating, the
reports will not reflect the information from statements printed since the last time the Update
Statements program was run.

Undo Updated Statements

Menu: Statements | Undo Updated Statement | Undo Single Updated Statement
| Undo Multiple Updated Statements
Home: Statements | Undo Single Updated Statement

Quick Launch: Undo Single Updated Statement
Undo Multiple Updated Statements

When a statement is updated, it is finalized and many changes occur to the data files. The Undo
Updated Statements programs reverse these changes by restoring client data to its pre-update status
and unbilling the final statements that were run (i.e., the Status field for transactions on the
statements is changed back to “Print"). Updated statements for a specific client must be undone in
the reverse order they were updated.

Undo Single Updated Statement

The Undo Single Updated Statement \ Undo Single Updated Statermnent = e Sl
program can be used to undo a single

statement for a single client Client D: 9 B
. State v. Williams
Statement Number: v

Statement Information

Statement Date: 07/31/2022

Fees: 3057.50 Fee Tax: 0.00
Expenses: 38.60 Expense Tax: 0.00
Advances: 51.50 Advance Tax: 0.00
Finance Charge: 0.00 Payments: 1076.60

o | (o]

Figure 22, Undo Single Updated Statement window
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» To undo a single updated statement

1. From the Statements menu, point to Undo Updated Statement and select Undo Single

Updated Statement.

2. Enter the desired Client ID. The most recent Statement Number is automatically selected.

3. Click OK.

Undo Multiple Updated Statements

Undo Multiple Updated Statements
program can be used to undo statements
for multiple clients with the same
statement date.

» To undo multiple updated statements

_~ Undo Multiple Updated Statements == ==
Statement Criteria
Statement Date: v
Client ID: | | v Thru: | ‘ v | Multiple..
Name Search: | | Torw | |
Primary Timekeeper: | [+ o | |v
Secondary Timekeeper: | |v  hru | |v
Originating Timekeeper: | |v hru |v
Category: \ | v hru | |v

Figure 23, Undo Multiple Updated Statements window

1. From the Statements menu, point to Undo Updated Statement and select Undo Multiple

Updated Statements.

2. Enter the Statement Date of the statements you want to be undone.

Enter any other desired criteria.
4. Click OK.
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Unbill Final Statements

Menu: Statements | Unbill Final Statements
Home: Statements | Unbill Final Statements
Quick Launch: Unbill Final Statements

The Unbill Final Statements program allows you to reverse a final bill if it has not yet been updated.
This feature is useful when a client is unintentionally billed or you decide not to bill a client already.

When a final statement is run, Tabs3 Billing “tags” the transactions as “ready to be updated.”
Unbilling effectively “untags” the transactions so they remain in work-in-process and do not get
updated. The field that is tagged is the Status field. When transactions are entered, they are typically
entered with a "P - Print” status. When a final statement is run, the transaction is changed to "U -
Update” indicating the transaction is ready to be updated. Unbilling the final statement changes the
status of all transaction that were on the final statement from “U - Update” back to “P - Print”
thereby canceling the final statement.

Unbilling statements must be done prior to running the Update Statements program. If a final
statement has already been updated, then you must use the Undo Updated Statement program to
reverse the update process.
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Emailing Statements

When statements are generated, statements for clients who are configured to receive mail
statements will be sent to the printer, whereas statements for clients who are configured to receive
email statements will be sent to the Email Statements window. Statement delivery options are
configured in the Statement Delivery Options of the Client file (page 3). Once email messages and
statements have been reviewed and updated, they can be automatically sent from the Email
Statements window.

The ability to email statements from Tabs3 Billing requires either Microsoft Outlook or an SMTP
server and is designated on the Main tab of Tabs3 Billing Customization. If you select Outlook, no
further setup is required. If you select SMTP, you must configure the SMTP server in System
Configuration using the Settings | Outgoing Email Configuration program.

More Info: For additional information on emailing statements, see Tabs3 Billing Help or
Knowledge Base Article R11338, "Emailing Tabs3 Statements.”

You can include variables for a payment and/or trust deposit link in your email message, which
allows clients to pay their bill or deposit funds into their trust account online with a credit card, debit
card, or eCheck. See Knowledge Base Article R11905, “Requesting and Importing Tabs3Pay Online
Payments and Trust Deposits,” for more information.

Version Note: The Trust Request feature requires Tabs3 Software Version 2022 (Build 22.2.3) and
later.

Email Statements Window

Menu: Statements | Email Statements
Home: All Actions | Statements | Email Statements
Quick Launch: Email Statements

Use the Email Statements window to manage email statements; you can preview the email message
that accompanies the statement and edit the To, Cc, Bcc, Subject, and Body fields, review the PDF
statement, mark the statement as reviewed or on hold, and send the statement from this window.

-29-


https://support.tabs3.com/main/R11338.htm
https://support.tabs3.com/main/R11095.htm

Tabs3 Billing Statements Guide

Email Statements

o )

Client ID Client Name Work Description Contact

415.00 MegaConstruction Corporate Merger - James R, Tatiki, Sr.

QOptions Refresh

Larson/Michael  |Larson v. Bel-Cor | Michael Larson 100.00 Stmt 7623.pdf .. 07/31/2022 To Be Updated

Hold Reviewed Wiew/Edit Email Send Reviewed

Email Address PDF File Name Date Status ~

t@megamnmrp com | 415.00 Stmt 7621.pdf 3-RPA 07/31/2022 To Be Updated

v

Figure 24, Email Statements window

Options

Refresh

Hold

Reviewed

View/Edit Email

The Options button can be used to display the Email
Statements Options window (Figure 25), which allows you
to limit the records shown in the Email Statements window
based on Client ID or Primary Timekeeper. This window
also allows you to display only email statements within a
specific Statement Date range.

The Refresh button or F5 can be used to update the
information shown in the Email Statements window. Any
clients that no longer meet the email statements options
will be removed. New final statements that have been run
for clients will replace the original PDF statements, except
when statements have been updated or are open at the
time of the refresh.

The Hold button can be used to mark the selected records
as “on hold.” Check marks will be placed in the H (Hold)
column and the R (Reviewed) column. If the record was
already on hold, the check marks will be removed from the
H (Hold) and R (Reviewed) columns.

The Reviewed button can be used to mark the selected
records as “reviewed.” A check mark will be placed in the
R (Reviewed) column. If the record was already marked as
reviewed, the check mark will be removed from the R
(Reviewed) column.

The View/Edit Email button can be used to open the Email
Preview window (Figure 26) to review and edit the email as
well as view the attachment(s) that will be sent to the
client. The body of the email is determined by the Email
Template assigned to the client. The Email Preview window
can also be used to send the email, or mark the email as
“on hold"” or "reviewed.”
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Send Reviewed

More Info: Additional information on creating Email
Templates can be found in Tabs3 Billing Help and the
Statement Formatting Guide.

The Send Reviewed button sends all email statements that
have a check mark in the R (Reviewed) column of the
Email Statements window. Only statements that have been
updated can be sent. Therefore, if any statements in the
Email Statements window have been reviewed, but not
updated, you will be prompted to update statements
before the email statements are sent.

Any statements that have a check mark in the H (Hold)
column along with a check mark in the R (Reviewed)
column will not be sent until the hold status is removed.

Email Statements Options
Client

Client 1D:

Timekeeper

Primary Timekeeper

Statement Date

Statement Date:

mm;/dd/yyyy ¥ Thru: | mm/dd/yyyy v

b

Y Thru: I:l" Multiple...

Cancel Help

Figure 25, Email Statements Options window
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& Email Preview - 850,00 White/Kelly - O x

E{{]Send ﬂgHoId ﬁReviewed E@ x& Q_.r e e

Subject: | Your statement from Jensen, Martin & Anderson, P.C. is attached

HEODLBIVYVEEECEEEQRAC

From: | "Michael L. Jensen" <mjensen@jensenlaw.com> |
To: | "Kelly Ann White" <kelly_white_la@hushmail.com=> |
cc | |
Bco | |

Dear Kelly,

~
Your statement is ready and attached to this message.
Statement Date
04/18/2022
Statement Number
7624
Accounts Receivable Balance Due
$315.00
Powered by Tabs3Pay

Your current Trust Account balance is below the desired minimum
balance. Please remit $2,500.00 to deposit into your Trust Account. v

[ For |

e

850.00_5tm...

Figure 26, Email Preview window

Email Statements Report

Menu: Statements | Email Statements Report
Home: All Actions | Statements | Email Statements Report
Quick Launch: Email Statements Report

The Email Statements Report shows all email statements that are successfully sent to clients who are
set up to receive email statements. For each email that meets the selected criteria, the client, email
date, recipient information, file name, statement date, and User ID of the sender are included in the
report, as shown in Figure 30.
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& Email Statements Report + | & Emal Stotements Repart f
X . 1
Client  Options Sort Client  Options  Sort b
. i
Client ID: | ‘ v Thru ‘ | v Multiple... Report Date: - v 1
« {
{ Report Criteria j
1 Contact: ‘ | ¥ Thru: | ;
Name Search: | ‘ Thru: ‘ | i k|
Statement Date: ‘mm/ddﬂm |v Thru: |mm/ddfym ‘ v 1
Primary Timekeeper: Thru:
g ° l:l v l:l v ; Email Date: ‘mmfdd/wyy | ¥ Thru: |mm/ddfww ‘ v ;
Secondary Timekeeper: Thru: '
Feandary fimekeeper: l:l s ru l:l v 1 User ID: ‘ |v Thru: | ‘ v "
Originating Timekeeper: v Thru: v 1 f
Cat g Thru:
e e | (e :
(O Landscape 3
Billing Frequency: ® Al O specific Select Billing Frequency... } }
i Print i
Location: @ all O specific Select Location... 3 [ criteria Page i
; 1
Status: @4l Ospecific Select Status.. 1 4
4
Open/Close Dates: @2l O specific Select Dates... ! ;
,‘ !
i 4
Figure 27, Email Statements Report Figure 28, Email Statements Report
Client tab Options tab

& Email Statements Report

Client  Options Sort

Report Order Secondary Order
@ Primary Timekeeper @ cClient ID
O secondary Timekeeper O client Name Search
O ariginating Timekeeper (O Email Date

Working Timekeeper
O(ategury
O None

[Jstart Each Report Order on a New Page

Lk et 1tk 1 A, b s b, e TR, S A B

Figure 29, Email Statements Report
Sort tab
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Client tab The Client tab allows you to specify a range of clients,
timekeepers, categories, billing frequencies, locations,
open dates, and close dates. You can also select clients
based on status (i.e., active clients, progress billing clients,
billable clients, email and/or mail clients, and task based
billing clients).

Options tab The Options tab allows you to specify a range of contacts,
statement dates, email dates, or user IDs.

Sort tab The Sort tab allows you to select the order in which the
information should appear on reports.

Date: 08/22/2022 Tabs3 Email Statements Report Page: 1
Jensen, Martin & Anderson, P.C.
Email Date Contact Email Address PDF File Name Stmt Date  User ID
100.00 Larson/Michael
RE: Larson v. Bel-Cor
08/01/2022  Michael Larson mlarson@larson.com 100.00_Stmt_7619.pdf 07/31/2022 RON

101.00 Williams/John
RE: State v. Williams
08/01/2022  John Williams jw2000@net.com 101.00_Stmt_7622.pdf 07/31/2022 RON

415.00 MegaConstruction Corporation
RE: Corporate Merger - Megabuilders and BuilderCorp
08/01/2022  James R. Tatiki, Sr. jt@megaconcorp.com 415.00_Stmt_7624.pdf 07/31/2022 RON

850.00 White/Kelly

RE: Divorce
08/01/2022  Kelly Ann White kelly_white_la@hushmail.com 850.00_Stmt_7625.pdf 07/31/2022 RON
08/01/2022  Kelly Ann White kelly@homeoffice.net 850.00_Stmt_7625_Dup.pdf 07/31/2022 RON

850.02 White/Kelly
RE: Medical Care of Brianne
08/01/2022  Kelly Ann White kelly@homeoffice.net 850.02_Stmt_7623.pdf 07/31/2022 RON

Figure 30, Example of the Email Statements Report

Training Videos

You can view the following training video for more information. Clicking the link will open the
training video in your browser. All training videos are also accessible in the software via the Help |
Training Videos menu and at Tabs3.com/video.

u Email Statements Overview
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Reprinting Statement Information

There are several methods for reprinting information that was included on a statement, depending
on the type of information you want. In this section, we will cover the Reprint Updated Statements
program, the Client Ledger Report, and the Transaction File List.

Reprint Updated Statement

Menu: Statements | Reprint Updated Statements | Reprint Single Updated Statement
| Reprint Multiple Updated Statements
Home: All Actions | Statements | Reprint Single Updated Statement

Quick Launch: Reprint Single Updated Statement
Reprint Multiple Updated Statements

The Reprint Single Updated Statement and Reprint Multiple Updated Statements programs allow you
to reprint a statements that has been updated. This enables you to easily reproduce previously billed
statements from any period.

Reprint Single Updated Statement

The Reprint Single Updated Statement ) Reprnt Single Updated Statement o] )
program allows you to reprint statements

one atatime Client 1D: 121.00 v Phillips/Marcus
’ Real Estate Acquisition
Statement Number: v

Statement Information

Statement Date: 07/31/2022

Fees: 425410 Fee Tax: 0.00
Expenses: 52.25 Expense Tax: 0.00
Advances: 275.00 Advance Tax: 0.00
Finance Charge: 0.00 Payments: 269.93

Figure 31, Reprint Single Updated Statement window

» To reprint a single updated statement

1. From the Statements menu, point to Reprint Updated Statements and select Reprint Single
Updated Statement.

2. Enter the Client ID for which you want to reprint a statement.
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3. Select the Statement Number of the statement to reprint.
4. Click OK.

Reprint Multiple Updated Statements

The Reprint Multiple Updated Statements | {C reprint Multiple Updated Statements [ -E ]
program allows you to reprint multiple Statement Criteria
statements at one time. Statement Date: v Th v
Client ID: | | v Thru: | ‘ v | Multiple..
MName Search; | ‘ Thru: | |
Primary Timekeeper: ‘ | v Thru: | | v
Secondary Timekeeper: | | v hru | |v
Originating Timekeeper: ‘ | v Thru | | v
Category: ‘ | v Thru | | v

Reprint Options
[individual POF for each Statement (Using DropBox or Print to File/PDF)
[JPrint Statement Run Totals

o | o]

Figure 32, Reprint Multiple Updated Statements window

» To reprint multiple updated statements
1. From the Statements menu, point to Reprint Updated Statements and select Reprint
Multiple Updated Statements.
2. In the Statement Criteria section, enter the desired criteria.

3. In the Reprint Options selection, optionally select to generate an Individual PDF for each
Statement.

4. Click OK.

Client Ledger Report

Menu: Reports | Client Reports | Client Ledger Report
Home: All Actions | Reports | Management Reports | Client Ledger Report
Quick Launch: Client Ledger Report
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The Client Ledger Report shows the amount of payments, fees, expenses, advances, finance charge,
fee sales tax, expense sales tax, advance sales tax, and balance due for each statement. Payment
activity (including payment reversals), write offs, and balance due information are also included.

Detailed billed information that shows amounts billed by timekeeper and Cost Type can optionally

be included on the detail reports. A report showing only write offs can be generated.

The following tabs are available in the Client Ledger Report:

(8 Client Ledger Report

Client  Options Format Sort

Client ID: | | v Thru: ‘ | v Multiple...

Name Search: | | Thru: ‘ |

Primary Timekeeper: I:l w Thru: I:l w

Secondary Timekeeper: I:l w Thru: I:l w

Qriginating Timekeeper: I:l v Thru I:l v

Category: I:l w  Thru: I:l v
Billing Frequency: @ al O specific Select Billing Frequency...
Location: @ Al O specific Select Location...
Status: ® Al O specific Select Status...
Open/Close Dates: ® Al O specific Select Dates...

1 & Client Ledger Report
i Client Options Format Sort
4
Date
Beginning: | mm/dd/yyyy | ¥ Ending:
Print

Minclude Zero Balance Clients

[ Group By Client

[ start Each Client on a New Page

[ Detail Information for each Statement
[ Detail Information for each Subtotal
[write offs only

O criteria Page

WIP Pymt Cut-Off Date: v

Ep

Type
@ Detail
[JDouble Space Report

O summary

i A S, s SR A b kA A SR M sy kA At e L

Figure 33, Client Ledger Report
Client tab

Figure 34, Client Ledger Report
Options tab
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5 Client Ledger Report 1| & Client Ledger Report ]
1 4
Client  Options Format Sort ) Client  Options Format Sort 1
Include :: Report Order Secondary Order j
[JReference Number [ Advance Tax ; O Primary Timekeeper @ Client ID 1
4
[ statement Number [ Apply to Statement Number ]’ O secondary Timekeeper O Client Name Search :
[ Hours [ gill Total 1 (O oOriginating Timekeeper 1;
4

[IFinance Charge [1Balance Due 1 Working Timekeeper 1
[JFee Tax [Inon-Billable Information { O category ;‘
4 4
[JExpense Tax 3 @ None ‘
“ Start Each Sort on a New Page :
Qrientation 1 {
O portrait J Totals ;_
@® Landscape { [ Totals Only ;
: [ subtotal by Client q
3 «

: Client subtotals Only
7 {
1 [ Grand Totals )
1 d
4 4
3 {
i k
{ 1

Figure 35, Client Ledger Report Figure 36, Client Ledger Report
Format tab Sort tab

Client tab The Client tab allows you to specify a range of clients,
timekeepers, categories, billing frequencies, locations,
open dates, and close dates. You can also select clients
based on status (i.e., active clients, progress billing clients,
billable clients, email and/or mail clients, and task based
billing clients).

Options tab The Options tab includes parameters that enable you to
print a detail or summary report as well as specify what
type of information is included on the report (e.g., include
zero balance clients, detail information for each statement,
write offs only, etc.).

Format tab The Format tab allows you to optionally include
information such as reference numbers, hours, bill total,
and balance due as well as specify whether the report will
print portrait or landscape.

Sort tab The Sort tab allows you to select the order in which the

information should appear on reports.
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» To run a Client Ledger Report

1. From the Reports menu, select Client Reports, and then click Client Ledger Report.
On the Client tab, select the desired Client ID or range of clients.

On the Options, Format, and Sort tab, select any other desired options.

Click OK.

> wopn

Transaction File List

Menu: Reports | Transaction Reports | Transaction File List
Home: All Actions | Reports | Transaction Reports | Transaction File List
Quick Launch: Transaction File List

The Transaction File List is one of our most flexible reports and can be used to determine which fees,
costs, and payments have been final billed and updated based on various options. The Transaction
File List is a means of sorting and listing fee, cost, and payment transactions stored in Tabs3 Billing.
This report can be used as an alternative to reprinting individual statements, as it can be configured
to print all final billed and updated transactions subtotaled in Statement Date order.

The following tabs are available in the Transaction File List:

& Transaction File List & Transaction File List 1
Client  Transactions Options Format Sort Client ~ Transactions Options Format Sort J
{
Client ID: ‘ ‘ v Thru: | ‘ v Multiple... 3
[AFees Fee Timekeeper: l:l v Thru: l:l v
Fee Date: |mm/dd/‘)’m' | v Thre ‘mm/ddf)'m' ‘ ©

Category: l:l v Thru: l:l v

[ only Include Fee Credits

[ Expenses Cost Timekeeper: l:l v Thru: |:| v

Primary Timekeeper: Thru:

Secondary Timekeeper: l:l v Thru l:l v
(I L I
[ 1% e[ e

Originating Timekeeper: Thru:

L e A i o e A . A s e A e L~

P U P S A S A S P

Category: Thru: [Advances  Cost Date: |mmfddf‘)’w)' | v Thru ‘mm/dd/’)’)’)’)’ ‘ v
oo | |v | v
Billing Frequency: (O] O specific Select Billing Frequency Cost Type: |:| . D
ype: Thru:
Location: @ all O specific Select Location... [J only Include Cost Credits
Status: @ all O specific Select Status.
B4 Payments Payment Date: |mm/dd;)'yy)' | v Thru: ‘mm/ddfyyyy ‘ v
Open/Close Dates: Il if Selec €5,
pen/closebates @A Ospedic e payment code: || s [ |
Figure 37, Transaction File List Figure 38, Transaction File List
Client tab Transactions tab
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O Transaction File List ]| & Transaction File List i
1
Client  Transactions Options Format sort P Client  Transactions Options Format sort :
4 i
Type Bill Status j Include Columns Qrientation }
®Detall Osummary  Report Date: 08/22/2022 | HBillable : & client 1D [ sales Tax Code @ portrat :
B Non-
Source Transactions FINen-billable : Cuser i [I8ill Code O Landscape f
Billing M Work-n-Process status ; [JEntry Date [JRate Code ¥
Archived
Remote larchive Hold 1 [ Transaction Date [ cost Type (
3 ,
4
Data Import print EJprint ; [Jstatement Date M Transaction Code 1
. 1
[ Timekeeper Initials [ save b
DA bracticeMaster o P! A 1, [ Timekeeper 7 Rate/Stmt # :
&
I client Name 3 [ exp/adv/Categary [ units M
B Accounts Payable M work Description { 3
i [source [ Hours Worked 1
M Trust [J6Ls information Date Selection i P
[criteria Page Statement 1 [ status M Hours ta Bill i
M quidooks Transaction 1 f
- { [ Receipt Type & amount 1
P
Export Data Format { [ check # Description ]
f 3
@®none  Ofixed O Comma Delimited O Tab Delimited O Pipe Delimited ! [IRef./Memo Reference Number ;
“ !
f Clear All Select All Default 4
; i
. {
4 o
Figure 39, Transaction File List Figure 40, Transaction File List
Options tab Format tab
(& Transaction File List :
Client  Transactions Options Format Sort j
)
1st Sort Order b
Client ~| Msubtotal 1

[ start Each Sort on a New Page

2nd sort Order

Transaction Date ~  [Hsubtotal

3rd Sort Order

MNone v Subtotal

it Ay B, s S, e A R

Figure 41, Transaction File List
Sort tab

Client tab The Client tab allows you to specify a range of clients,
timekeepers, categories, billing frequencies, locations,
open dates, and close dates. You can also select clients
based on status (i.e., active clients, progress billing clients,
billable clients, email and/or mail clients, and task based
billing clients).
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Transactions tab The Transactions tab allows you to specify the
transactions to be included based on transaction type
(fees, costs, or payments), date, transaction code, working
timekeeper, category, and cost type.

Options tab The Options tab includes parameters that enable you to
print a detail or summary report as well as specify the type
of transactions you want to include on the report.

Tip: Be sure to select the Archived check box. Selecting
this option includes transactions on the report that have
been final billed and updated.

Format tab The Format tab allows you to specify which columns you
want to include and if you want to print the report in
portrait or landscape orientation. All columns are optional,
but at least one column must be selected.

Sort tab The Sort tab allows you to select the order in which the
information should appear on reports.

» To run a Transaction File List for statements

1. From the Reports menu, select Transaction Reports, and then click Transaction File List.
On the Client tab, select the desired Client ID or range of clients.

On the Transactions tab, leave everything blank.

M oW

On the Options tab, in the Transaction section, clear the Work-In-Process check box and
select the Archived check box.

v

In the Date Selection section, select Statement.
6. On the Format tab, select the Statement Date check box.

7. On the Sort tab, in the 1st Sort Order section, select Client and select the Subtotal check
box,

8. In the 2nd Sort Order section, select Statement Date and select the Subtotal check box.

9. Click OK to print the report.

This is just one of the many ways to run the Transaction File List.
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Date: 08/22/2022

Detail Transaction File List
Jensen, Martin & Anderson, P.C.

Page: 1

Trans H Tcode/ Stmt # Hours
Client Date  Tmkr P Task Code Rate to Bill Amount
Client ID 101.00 Williams/John
101.00 05/26/2022 1A 19 250.00 0.30 75.00 Initial Client Meeting
Subtotal for Statement Date 05/31/2022 Billable 0.00 0.00
Non-billable 0.30 75.00
Total 0.30 75.00
101.00 06/13/2022 1A 18 250.00 250 625.00 Prepared for conference with client.
101.00 06/17/2022 2 A 250 5.75 Long distance telephone charges.
101.00 06/20/2022 1A 251 7.50 Photocopy charges.
101.00 06/20/2022 2 A 250 10.50 Long distance telephone charges.
101.00 06/20/2022 2 A 253 2.90 Postage.
101.00 06/21/2022 1A 250 6.75 Long distance telephone charges.
101.00 06/23/2022 1A 3 250.00 0.25 62.50 Telephone conference with client.
101.00 06/27/2022 1A 253 2.50 Postage.
Subtotal for Statement Date 06/30/2022 Billable 275 723.40
101.00 07/21/2022 3 A 25 1.25 Facsimile costs.
101.00 07/25/2022 1A 9 250.00 3.00 750.00 Review and analyze case status.
101.00 07/25/2022 1A 1 250.00 0.50 125.00 Legal Research.
101.00 07/25/2022 1A 10 250.00 1.50 375.00 Legalresearch.
101.00 07/25/2022 A 900 1,076.60 Payment
101.00 07/25/2022 2 A 251 7.35 Photocopy charges.
101.00 07/25/2022 3 A 251 30.00 Photocopy charges.
101.00 07/25/2022 3 A 102 47.50 Courier fee (325) Professional Messenger Services
101.00 07/27/2022 2 A 106 4.00 Online legal research (300) Thomson Reuters Payment
Center
Subtotal for Statement Date 07/31/2022 Billable 5.00 1,340.10
Payments 1,076.60
Total for Client ID 101.00 Billable 7.75 2,063.50 Williams/John
Non-billable 0.30 75.00 State v. Williams
8.05 2,138.50
Payments 1,076.60
GRAND TOTALS
Billable 775 2,063.50
Non-billable 0.30 75.00
Total 8.05 2,138.50
Payments 1,076.60

Figure 42, Example of a Transaction File List
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Conclusion

Resources

Additional information on the features discussed in this guide can be found in the Tabs3 Billing
Help. Simply press F1 from anywhere within the software to load the Help information for that
particular topic.

Guides

Additional guides and resources for separate software features are also available, including the
following:

« Statement Formatting Guide - This guide provides the information on the tools to give your
statements the look you want. Over 20 pages of sample statements, and the formatting
options that were used to create the statements, can be found in the appendix.

« Billing Methods Guide - This guide provides information on the various methods of billing
clients that are available in Tabs3 Billing. It includes information on basic billing concepts
that are important to individuals who enter client information in Tabs3 Billing.

All guides and sample report packs are available on our Web site at:

Tabs3.com/support/docs.html

Knowledge Base
Our Knowledge Base can be accessed 24 hours a day, 7 days a week. You can also access our
Knowledge Base while in the software by selecting Help | Internet Resources | Knowledge Base.

« R11582, "Statements Information Resources” - This is a comprehensive list of KB Articles
containing more information about Tabs3 Billing statements.

o R11338 - Emailing Tabs3 Statements

All Knowledge Base Articles are available on our Web site at:

support.Tabs3.com

Training Videos
Tabs3 includes numerous training videos to help you learn the software. Training video libraries can
be accessed via the software from the Help | Training Videos menu option.

-43-


https://www.tabs3.com/support/docs.html
https://support.tabs3.com/main/R11582.htm
https://support.tabs3.com/main/R11338.htm
https://support.tabs3.com/

Tabs3 Billing Statements Guide

The following training videos contain information on generating statements. Clicking a link will open
the associated training video in your browser.

n Statement Generation Basics

n Getting Started with Clients

u Flat Fee Billing
n Split Billing

u Email Statements Overview

Tabs3 Support

Tabs3 Software provides some of the best support in the industry. Service to our customers is
extremely important to us—so much so that our motto is:

Reliable software. Trusted service.

Support is provided at no charge with a maintenance plan and is available from 8:00 a.m. to 5:00 p.m.
Central Time, Monday through Friday. If you have any questions, please feel free to call our Support
staff at (402) 419-2210.

Email support is also available for all firms on maintenance. Our support team responds to emails
during office hours. Our goal is to respond to your question within one business day. Please keep in
mind that time-sensitive and complex issues are better handled over the phone. To request email
support, visit Tabs3.com/support.
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